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Learning to Say Good-bye
When you want to leave Logo, type BYE.  Some Logo 

versions use GOODBYE

A message box is displayed asking if you really want to 
leave Logo.

You can also select File/Exit to leave Logo.  If you have 
not saved your workspace, the message box is displayed asking 
if you really want to leave Logo or not.

________________________________________________

Writing Your Own Logo Journal
As you explore Logo, you’re going to discover all sorts 

of things.  There are some spaces in this book to write things.  
But it is also a good idea to have your own book where you 
can write down ideas and other things you want to remember.

That’s how Logy did it.  She did the exercises in the book 
and then went off and made up lots of other things all on her 
own.  Along the way, she wrote down her ideas so she could 
work on them again whenever she wanted.

That’s important!

Take your time.  Let the exercises in this book be the 
stepping stone to the many other things you can enjoy on your 
own 

            Great Logo Adventure!
________________________________________________
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Printing and Saving Your Pictures
Everyone wants to see their work in print, right?  That’s 

very important, especially if you’re working at school and you 
want your parents to see what you’re doing.  

All you need is a printer that is set up to print in your 
version of Windows.  If you don’t have a printer available at 
school, you can save your pictures and print them at home.  Of 
course, you have to have a computer and a printer at home.

To print pictures:
The easiest way to print your pictures is to open the 

Bitmap menu and select Print.

Your picture is printed on your Windows printer.

To save pictures:
You have a choice: you can open the Bitmap menu and 

select Save or you can use the BITSAVE command.  In either 
case, give your picture a name and type

BITSAVE "<picture name>.BMP

Your picture is saved in the MSW Logo directory.
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You can use this maze on the screen.  Or why not make 
up your own maze.

Pick up the pen and move the turtle to where it says Start.  
Then put the pen down and see if you can move the turtle 
through the maze to the opening in the upper left corner.

If you want to make it tough for your friends, use colored 
erasable markers to draw pieces the turtle has to pick up before 
she leaves the maze.  Erase each piece as the turtle lands on 
that spot.

Another challenge is to see who can get through the maze 
in the least number of moves.

All of these things are great practice using the turtle’s 
direction and turning commands.

Go on, see what else you can do!

________________________________________________
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Get your soccer fans to draw a soccer field on the Logo 
screen.  Then save it as a picture.  Now you can pick up teams 
to play soccer, or “football” as they call it in other countries.

You can use the same rules for Logo Soccer as you use 
for Logo Football.  Or you can get as realistic as you want.  
That’s up to you.  If a player gets through the defense, he or 
she has to “shoot the turtle” through the goal.

You can make up the same type of game for ice hockey, 
too.  We already have a basketball game that you’ll discover 
later on.

________________________________________________

Make Up Your 
Own 
Adventures

Now, why not make up some adventures of your own?  
To get you started, why not draw the letters of your name.  

There are all sorts of things you can dream up, I’ll bet. 

Did you ever play "Blind Man’s Bluff?"

Clear the screen.  Then put a cover over it so you can’t 
see what the turtle’s doing.  Then give the turtle some 
commands to draw a letter maybe.  When you’re finished, take 
the cover away and see how you did.  Is the picture what you 
thought it would be?

There’s a picture on the diskette that came with your book 
called MAZE.PCX.  It’s shown on the next page.
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How to Play 
Football

To play football, you need two teams.  One team is the 
offense and one is the defense.  The team that is on defense 
must place eleven small stickers on the screen to stop the 
offense from getting a touchdown.  They can place the stickers 
anywhere on the screen.  However, there must be enough room 
between the defense stickers to allow the turtle to go through 
without touching any of the defensive players.

The defense can also draw their defensive players on a 
piece of clear plastic taped over the screen, using an erasable 
marker.  When the defense becomes the offense, all you have 
to do is wipe off the plastic and redraw the defense wherever 
you want it.

 
What about the offense?

The offense has to move the turtle from their goal line 
through the defense to the goal line on the other side of the 
screen without touching a defense sticker.  The offense gets 
four downs, or four chances to make a touchdown.  If they 
don’t, they have to turn the ball over to the defense who then 
gets their chance to make a touchdown.

Logo football is a lot of fun, especially if you live in a big 
football town.

“But what about the extra point?”

“Well, why don’t you make up your own rules about extra 
points after the touchdown.”

________________________________________________

Logo Soccer There are all sorts of sports games you can think up for 
Logo practice.
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Now go to Second Base in three moves or less.  Then go 

to Third.  And now go back Home plate.

Get some friends together and see who can run the bases 
in the fewest number of moves.  To add some more fun to your 
game, move the stickers to different spots on the screen.  
____________________________________________________________________

Logo Football If you don’t like baseball, why not try Logo Football?  
Logo and Morf live near Dallas, Texas, the home of the Dallas 
Cowboys.  They’re really big football fans.

Here’s how to play Logo Football.  

Draw a football field on the screen or on a sheet of clear 
plastic taped to the screen. 

 This picture of a football field is on the diskette that came 

with this book.  To load it into MSW Logo, make sure your 
diskette is in drive a: and type:

BITLOAD "A:\\PCX\\FOOTBALL.PCX

________________________________________________
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Put a small reward on each dot — maybe a prize or a piece 
of candy.  Then you can see who can collect the most prizes 
or candy.

You know, this is sort of like a game of golf.  In fact, when 
you get through this book, you can create your own Logo golf 
game.

________________________________________________

Rabbit Trail 5. Logo Sports
Everybody likes baseball.  Well, just about everybody.

Anyway, you’ll find that playing baseball on the computer 
can be lots of fun.

Put four small stickers on the screen for bases.  If you 
don’t have stickers, use tape.  Don't press too hard.  You want 
the sticker or tape bases to stick but you also want to be able 
to unstick them.

Can you put the turtle on First Base in no more than three 
moves?  (That’s like three strikes.)  Good, you’re safe. 
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streets and making all those turns.  (All they had to do 
was lift the pen up.)

Working with maps and developing games leads to all 
sorts of wonderful possibilities.  Hopefully the ideas offered 
here will lead to many more of your own.

________________________________________________

Connect the 
Dots

Have you ever played “Connect the Dots?”  There are 
many different versions of this game.  Let’s make up a Logo 
version.

Draw some “dots” on the computer screen using an 
erasable marker.  Then use the Logo commands you know to 
draw lines that connect the dots.  

What did you draw?  A crazy animal?  Or just a crazy 
mess of lines?

OK, maybe your artwork isn’t a masterpiece.  But you can 
get some good practice with Logo commands this way.

________________________________________________

A Dot Challenge Clear the screen to erase the dots.  Now draw some new 
dots in different places and number them.  Can you move to 
Dot #1 in just one move?  Can you guess the angle to turn to 
get to Dot #2?  Can you guess how far it is?

This game is fun to play off the computer with a group.  
Use chalk marks or tape on the floor as the dots.

How about making it more interesting? 
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Fun With Game 
Design

Now back to Turtle Town and other games.  We talk a lot 
about games in our books.  Games are fun, aren’t they?  Who 
ever said that learning can’t be just as much fun?

Designing games can be lots of fun, too.  Not only does 
it make you think through a whole series of Logo commands, 
it means you have to plan your game carefully so that players 
will understand what they have to do — and that it’ll be fun!

What makes one game fun and another not so much fun?  
A good game is a challenge.  It makes you feel good when you 
finish it, especially if you win.

A good game makes you think.  If the game is too easy, 
it’s not much fun, is it?  After all, if you win all the time, that 
get’s boring.

A good game is easy to understand.  If you don’t know 
what you’re supposed to do, how can you win?  So make sure 
that the rules to your game are clear.

What about playing a game?

Well, the same goes for players.  They have to think very 
carefully to play and win!   They have to plan their moves or 
they may find themselves getting lost or confused.  It’s good 
practice — and fun, too!

Here are some ideas some other players came up with 
when playing a Turtle Town game:

•  One team added the feature that any player who drove 
off the road had to go to jail and miss three turns.

•  Another team developed a game winning strategy when 
they turned the turtle into a helicopter so they could 
get across town directly, rather than move through the  
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To change the Windows 95/WIndows NT screen:
Those using Windows NT 3.5.1 or an earlier version need 

to follow the instructions for Windows 3.1.  If you’re using 
Windows NT 4.0, follow the instructions below.

1. Right-click (press the right mouse key) on the Start button 
in the lower right corner of your screen.

Left-click on Open from the small menu that is 
displayed.

2.  Double-click (press the left mouse key two times very 
quickly) on the Programs icon or folder.

A list of program folders is displayed.

3.  Right-click on the MSW Logo folder.

Another Open menu is displayed.

4.  Left-click on Properties to open the MSW Logo 
Properties dialog.

The MSW Logo Properties dialog is displayed.

5.  Left-click on the Shortcut tab at the top of the dialog.

The Shortcut page is displayed.

6.  Add the height and width of your screen to the Target field 
following logo.exe using -h and -w as Logy and Morf did 
above.  Left-click on OK to close the dialog.

The MSW Logo Properties dialog is closed.

7.  Close the other windows and then click on the MSW Logo 
icon.

MSW Logo starts with your new screen dimensions 
active.

Turn on the Fence and check to make sure Ernestine goes 
out of bounds at the edge of the screen.

________________________________________________



Getting Started

46                                                                                                           

Fencing In Your 
Screen

"Logy, the screen on my notebook computer is much 
smaller than the screen on your computer.  Ernestine may think 
that the screen is 500 steps from the center of the screen to the 
edge.  But If I go forward more than 200 steps, the turtle 
disappears off my screen.  How come?"

The size of your screen really has nothing to do with the 
size of the MSW Logo window. That window simply goes 
beyond the edge of your screen. If you want to change your 
screen so that it is the size of your screen, that’s easy enough.  
But, first you have to measure your screen.

Morf found that the screen on his notebook computer was 
660 steps wide by 400 steps high.  Logy’s screen is 970 steps 
wide by 660 steps high.  

To change the Windows 3.1 screen:

1. Open the File menu and left-click on Exit to leave Logo.

The MSW Logo screen closes.

2.  Left-click once on the MSW Logo icon to highlight it.

The icon changes color.

3.  Open the Windows File menu and select Properties.

The Properties dialog box is displayed.

4.  Logy would change the Command line to read:

logo.exe -h 660 -w 970

Morf would type:

logo.exe -h 400 -w 660

Type the height (-h) and width (-w) of your screen.

5.  Left-click on OK to change the settings for your computer.
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at coordinates 0, 0.  Don’t worry about the SHOW and POS 
commands right now — or about coordinates.  You won’t need 
them for a while.  Now type

FD 1000  (Don’t forget to press Enter.)

Wow!  There’s a line drawn up and down the screen.  Now 
type

SHOW POS  (Press Enter here, too.)

Where are you?  Does it say [0 0] again?  Just so you know 
that Ernestine isn’t teasing you, type

FD 100 SHOW POS

Now what does it say in the Commander window?  Morf 
got [0 100].  What did you get?  This shows that you changed 
your coordinates to 0, 100.  You went FD 100.

Now clear the screen — you remember how to do that 
don’t you?  Let’s try the same thing in the other direction.  Type

RT 90 FD 1000 SHOW POS

Yes, you can type more than one command on one line.  
Just remember to press Enter when you want Ernestine to do 
her thing.

What happened?  Are you back HOME again? If it says 
[0 0] in the Commander window, that’s exactly where you are.

________________________________________________
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It’s right back HOME, isn’t it?  It only went to the edge 
of the screen and then printed the message

The turtle is out of bounds.

One more test — type

WINDOW

Type FD 2100 one more time.  Where’d the turtle go?  To 
find out type

BK 1000 Nothing yet.

BK 1000 There it is, but it’s not HOME.  Try

BK 100 Where’s the turtle now?

Type HOME just to be sure.  Go ahead and play with these 
commands a bit.  The next project is a good place to start.

________________________________________________

How Big Is Your 
Screen

Here’s a fun-type project for you.  How big is your screen?

When MSW Logo was installed, it set the screen to 1000 
turtle steps high and 1000 turtle steps wide.  If you want to 
prove this, here’s something to try.  Type

SHOW POS

and then press Enter. 

[0 0] is printed, or shown, in the Commander window.  
That tells you that the turtle is HOME in the center of the screen 
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During that period of time, you couldn’t travel from 
Alaska to Russia.  It was like there was a Fence between the 
two countries.

Here’s something to try.  Bring the turtle HOME and then 
drive back up to Alaska on the map.  Just before you cross over 
into Russia, type

FENCE

Now when try to cross into Russia, what happens?

It’s like there’s a fence that runs around the edge of the 
screen.  You can’t move beyond it.  Logo gives you a message:

The turtle is out of bounds.

________________________________________________

Check It Out Now let’s check this out to make sure you know just how 
these three commands work.  Type

WRAP

Now type FD 2100.

The turtle draws a trail from bottom to top of the screen, 
stopping a ways up from HOME.  The turtle WRAPped around 
the screen.  Now type

FENCE

Now type FD 2100 again.

What happened this time?  To find out, type BK 500.  Now 
where’s the turtle?
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the globe, you’ll see that it is only about 40 miles from Alaska 
to Russia.

So what happened here?

Simple, if you are mapping out your trip on the map, you 
have to "wrap" from the point where you leave the map on one 
side to where you pick it up again on the other side.  If you 
want to see how this works on the computer, load the map 
that’s on the diskette that came with this book.  Type

BITLOAD "A:\\PCX\\MAP.PCX

Pick up the turtle’s pen and drive the turtle up to Alaska 
and across to Russia.  What happened?

The turtle wrapped around to the opposite side of the 
screen and appeared in Russia.

WRAP is the Logo command.  It is usually ON when you 
load Logo.  However, there may be times when you don’t want 
the turtle to wrap around.  Rather than wrap around the globe, 
maybe you want the turtle to fly off into space.  If that’s the 
case, use the command

WINDOW

This command opens the wind so the turtle can escape.  
The only way you can get the turtle back is to turn it around 
or just clear the screen.

It wasn’t that many years ago that Russia and the United 
States were in a cold war.  The two countries didn’t like each 
other.  But at least they weren’t shooting at each other.
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You can use your Pencil Turtle to play.  Or why not try a 
Walnut Turtle?

Carefully crack open a walnut so that you don’t break the 
shell.  You can then glue the walnut shell to the pencil turtle 
shape and move it around to try out different actions.

If you don’t have any walnuts, try cutting an egg carton 
apart.  The sections that the eggs sit in make good turtle shells 
too.

________________________________________________

Wrapping, 
Windows, 
Fences

No, you’re not going to wrap fences around windows.  
This refers to three new commands you need to know about, 
especially when you’re talking about Logo Geography.

Let’s take a look at Wrapping first.

Let’s say you’re going on a trip.  You’re going to leave 
the continental United States and travel to Alaska.  From there, 
you’re going to make the short jump across the Bering Sea to 
Russia and then travel across Russia to Europe.

The only problem is that on this map, the jump from 
Alaska to Russia is no small jump.  However, if you look at 

     Russia
Alaska

USA
 Europe
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If you leave HOME and turn East on Main Street, what 
direction do you turn?  Give yourself a big Gold Star if you 
said turn RIGHT.

Go East on Main Street to Pine Avenue and then turn 
South.  Do you turn LEFT or RIGHT?

Go West on Elm Street to Maple Avenue.

Go North on Maple Avenue to Main Street.

What direction must you turn to find the skyscraper at the 
corner of Main and Oak Streets?

What else can you do with your Turtle Town map?

To get you started, add some puzzles to the map such as 
temporary construction barriers that you have to go around.

Turn the map into a maze.

________________________________________________

Create a Turtle 
Town Game

Divide a group of friends into several teams.  Each team 
must then design it’s own turtle town game.  When completed, 
teams play the games developed by each other and vote on 
which is the best game.  This is also an activity that can be 
shared with other classes in the same or another school.

It’s better if you draw your town on a large sheet of paper.  
You can make it a bigger and better game that way.  If you 
need to find big sheets of paper, ask a local printer or 
newspaper if they have “proof sheets” or other scrap sheets or 
rolls you can have.  Proof sheets will have printing on one side 
but you can use the other side for your game.
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After you have had some fun moving around Turtle Town, 
why not get some friends together and see who can complete 
a trip in the least number of moves.  For example:

1. Go to Morf’s house.  That’s at the corner of Pine Avenue 
and Elm Street.

2.  Take lunch to your Morf’s father who works at the factory.

3.  Go to see your cousin who lives in the apartments on Main 
Street.

4.  Go get some candy at the candy store.

5.  Go back home.

________________________________________________

Rabbit Trail 4. Turtle Geography
Here’s something else you can do with a group of friends 

or your class.  Print the Turtle Town map.  Then you can use 
your Pencil Turtle to move around Turtle Town.  Or why not 
draw a map of your neighborhood and move your Pencil Turtle 
around on that.

Now let’s get on with some Turtle Geography.

You’ve been moving around the Turtle Town map by 
going FORWARD, BACK, LEFT and RIGHT.  Are these the 
directions you use to move around a map of the world, a map 
of your state, or your home town?

These other maps use the four directions, North, South 
East, and West.  We’ll talk more about these directions when 
we explore circles, clocks, and compasses.  But for now, let’s 
see what we can do with them using our map.  
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There is a copy of this map on the diskette that came with 
this book.  Why not load the drawing into Logo?  Then we’ll 
have some fun with it.  

To load the Turtle Town map:

1. Make sure that Logo is running and that the Sourcebook 
Book diskette is in drive A.

2.  Type BITLOAD "A:\\PCX\\TOWN.PCX and press Enter.  

The Turtle Town map is displayed.

Now let’s have some fun moving around town.  Start by 
lifting the pen up.  You remember how to do that, don’t you.

1. Start from your home and find the farm.

2.  Now find the factory.

3.  Now it’s time to go to school.
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Working with maps can be lots of fun, especially when 
they are done on the computer.  There’s a map of Turtle Town 
on the next page that shows where Logy and Morf live.
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Rabbit Trail 3. Exploring Turtle Town
Think about this for a moment.  Where does your best 

friend live?  From the front of your house, which direction do 
you turn to go to your friend’s house, right or left?  After you 
turn, how far do you go before you turn again?

Can you draw a map to his or her house?

Why not draw a turtle trail from the front of your house 
to the front of your friend’s house.  Pretend that each block is 
100 turtle steps long and that each street is 10 turtle steps wide.  
After you have drawn the turtle trail, write down the Logo 
commands to make the trip.

Here’s another challenge for you.   Can you draw the map 
that would use the following commands?

RT 90  FD 50
RT 90  FD 100
LT 90  FD 110
RT 90  FD 100
RT 90  FD 30

Pretend you are drawing a map to a friend’s house.  Once 
you get there, you can draw a picture of what your friends 
house looks like.

Here are a few blocks to give you a start.  Use these or 
draw and color your own map.
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Since the turtle is moving down the paper, the turtle turns 
to its left but your right.  If you’ve turned the Pencil Turtle like 
Ernestine would turn, you can check this out by looking at the 
front legs of the turtle.  They tell you which direction is which.

Remember, when you want to plan a drawing on paper, 
your Pencil Turtle can help you think about the moves the turtle 
will have to make on the screen.  

To help you even more while you’re making your drawing 
on paper, make a list of the commands you give your pencil.  
This makes it easy to remember when you type the commands 
on the computer.
____________________________________________________________________

Let’s Review You know how to tell the turtle to go FORWARD, BACK, 
LEFT, and RIGHT.  You can tell the turtle to draw with the 
PENUP or the PENDOWN.

  
Remember where HOME is?

What happens when you tell the turtle PENREVERSE?  

What about CLEARSCREEN?  CLEARTEXT?

CLEAN?   PENPAINT?

OK!   Time to do some more exploring off the computer!
____________________________________________________________________
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When that’s done, slide the turtle up near the top of your 
pencil so you can hold it underneath the turtle.  If it seems to 
slide around too much, use a piece of cellophane tape to hold 
it in place.

Ready to go?  Make sure the turtle is looking at the top of 
the paper.  Then give the Pencil Turtle a command like:

FD 50

When you want the Pencil Turtle to turn, turn your pencil 
so the turtle is facing where you want to draw your next line.

RT 90  FD 50

LT 90  FD 50

Get the idea!

Now try this.

RT 180

FD 100

LT 90

The turtle’s going 
to turn to its left.  But 
which direction is that 
to you?  

Your right?  Or your left?
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Rabbit Trail 2. Making a Pencil Turtle
Sometimes it’s hard to see how things work on the 

computer screen.  To get things clear in your mind, you just 
have to go back to the good old pencil and paper.  

But the pencil isn’t the same as a turtle.  

Here’s an idea to help you make a turtle drawing on paper.  
Let’s make a turtle for your pencil.  You can use the one we 
did or you can make your own turtle.

Using your pencil, 
make a drawing of an 
egg on a piece of heavy 
paper or cardboard.  

If you’re at home, 
maybe you could ask 
your Mom or your Dad 
for help tracing a real 
egg.  

But be careful, you don’t want egg all over your drawing.

Hold the egg carefully and then trace around the egg to 
draw an oval shape.  This looks like a turtle shell, doesn't it?

Now put a small circle, about the size of your pencil, in 
the middle of your turtle shell.  At the top of the shell, draw 
the turtle’s head.  Then draw the turtle’s right legs.  Then draw 
the turtle’s left legs.  

  
To help keep directions straight, put R on the right front 

leg and L on the left front leg.  Now you’re ready to carefully 
cut out your turtle.
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LT 90 BK 50

Sometimes it’s fun to just play around on the screen to see 
what you can do.  At other times, it’s fun to plan a drawing on 
paper first, and then put it on the screen.

Why not give that a try — first on paper, then on the 
screen.

If you run into a bit of trouble trying to figure out the Logo 
commands for your drawing, Morf has some ideas for you in 
his next Rabbit Trail.

________________________________________________
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What happened?  Just as important, what do you do now? 

 If you said to tell the turtle to put her pen back down, 
CONGRATULATIONS!  That’s the kind of answer that sends 
Logy into tailspins.  

 Give yourself a huge Gold Star!   And throw in a double-
dip ice cream cone too!

To stop erasing, tell the turtle to PENPAINT.

OK, now type FD 50.  Now what do you see?   It looks 
better, doesn’t it.  

Try this: Now try this:

FD 50 RT 90

RT 45 FD 75

FD 75  LT 90

PE FD 100

BK 75  PD



Getting Started

30                                                                                                           

But what about things you draw?  

Think about this.  

You have just finished a great drawing when you see a 
line that’s too long.  You don’t want to start all over again.  All 
you want to do is erase that one line.

Let’s try it and see what happens.  Draw this shape.

FD 50 RT 120

FD 50 RT 120

FD 60

Rather than erase the entire drawing because the last line 
is too long, just change what the pen is doing.  Since you want 
to erase that last line, you just move the turtle back over it.  

Try this:

PENERASE or PE in shorthand
BACK  or BK 60
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Erasing Did you ever type something you didn’t mean to type?  
Sure you did!   Well, all you have to do to change it is to back 
up and type over what you want to change.  

You can use the Backspace key to back up.  It’s the one 
with the arrow pointing to the left.  Put the cursor after the 
letters you want to erase.  Then press the Backspace key.  It 
moves to the left erasing one letter each time you press the key.

You can use the Delete key.  The cursor stays in one place 
while it erases the letter to right.  Go ahead, give both keys a 
try.  You’ll see the difference.

The other way to erase is to drag the mouse over the text 
you want to change.  Drag means to put the cursor in front of 
the section you want to change.  Press and hold the left mouse 
button.  Then drag the cursor (move the mouse) over the letters 
to change.  The section you marked reverses color.  Then 
release the left mouse button.  To change what you’ve marked, 
just start typing.  The marked section disappears.

OK, you know you can erase things that you type.  



Getting Started

28                                                                                                           

PENREVERSE  
 If there’s a line in 

the turtle’s path, it is 
erased.  If there is no 
line, the turtle draws 
one.

Why don’t you put these commands to work.  Make up 
some things to do and experiment.

________________________________________________

Hiding  the 
Turtle                        

If you want to get the turtle out of the way, type 
HIDETURTLE and press Enter.  Ernestine disappears!  

.  

You can abbreviate HIDETURTLE by typing HT  

To see the turtle again, what do you think the command 
will be?  Sure, it’s SHOWTURTLE or ST in shorthand.

________________________________________________

SHOWTURTLE or ST                HIDETURTLE or HT
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To tell the turtle to start drawing, tell her to put the pen 
down.

PENDOWN or PD in shorthand
FD 50

Awfully simple?  Or simply awful?  

But don’t think you’re going to get off this easy!   There’s 
more to it than that.  In MSW Logo, the turtle can do three 
things with the pen when it is down: paint (when the turtle’s 
drawing), erase, and reverse lines.  

 

PENPAINT 

The turtle draws lines.

PENERASE  

The turtle erases its steps.

PENUP or PU              PENDOWN or PD
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Learning Turtle Shorthand
Now that you know what the basic turtle commands are 

and what they will do, let’s make things easy.  Let’s try turtle 
shorthand:

FD        is the same as      FORWARD

BK        is the same as      BACK

RT        is the same as      RIGHT

LT        is the same as      LEFT

CS        is the same as      CLEARSCREEN

Get the idea?  

Good, then let’s try a few.  Here’s a list of commands.  
Some are already done for you.  Why don’t you fill in the 
blanks?  Then type your own commands on the computer.  

FD 100 RT 120 FD 60 BK 30

LT ____     FD ____  RT ____  BK ____

________________________________________________

The Turtle’s Pen So far we’ve been talking about the turtle drawing all  the 
time.  Ernestine always has her pen down to draw on the screen.

But what if you want the turtle to move without drawing 
a line?  What do you do to make that happen?

You guessed it!   You tell the turtle to pick up the pen.  

PENUP or PU in shorthand
FD 100  RT 90
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FD 10 - 5 Subtraction
FD 10/5 Division
FD 10 * 5 Multiplication
Now back to your experiment — what happened?  

The shape got bigger.  But it still looks like the letter N 
doesn’t it.   So I guess that means that turtle steps and turtle 
turns really are different!

•  Changing the number of turtle steps changes the size of 
the shape.   But it’s still the same basic shape.  

•  Changing the number of turtle turns changes the shape 
itself without changing the size of the lines.  

 
Go ahead, change the number of turtle turns.  Change 150 

to 120.  What happens when you change it to 180?  Why not 
try 310?  As you play around with numbers, you’ll begin to 
see how you can make the turtle do just what you want it to do.  

Now, think about this.  

What would happen if you changed the 10 * 5 to a 10 * 
8?  No, don’t do it on the computer.  Draw the change you 
think this might make.  Then do it on the computer to see if 
you were right.

Don’t worry about what you’re drawing or what the 
turtle’s trail looks like.  This is the time to explore, to discover 
what the turtle can do with the four commands FORWARD, 
BACK, RIGHT, and LEFT.

________________________________________________
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What letter does this shape look like?  How would you 
make this shape bigger on the screen?  

If you make the turtle move five times as many turtle steps 
forward, do you have to make the turtle do five times as many 
turns?  

________________________________________________
SPECIAL NOTE:  The words you 

type — FORWARD, RIGHT, BACK, and 
LEFT — are Logo “primitives.”  
Primitives are the action words, the 
instructions or commands that Logo 
already knows.  You use primitives to 
write procedures.  They’re the things you 
will teach Logo to do in Chapter 4.

 ________________________________________________

Let’s experiment.  Morf just loves experimenting.

Try this.  And don’t 
forget to press Enter 
when you’re done.

FORWARD 10 * 5
RIGHT 150
FORWARD 11 * 5
LEFT 150
FORWARD 10 * 5

The * sign tells the turtle to multiply 10 times 5 and move 
that many turtle steps.  You’ll learn more about Logo 
arithmetic later on.  If you want to practice a little now, try 
working with these arithmetic signs.

FD 10 + 5 Addition
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For another change, let’s take a turtle walk that’s a lot like 
these games.  This one is fun to play with your class in school 
or with your family or friends at home.

One player is the turtle and one is the computer operator.  
The idea is to tell the turtle how to walk through a big letter or 
shape.  The others in the room have to guess what the turtle is 
drawing.  

The turtle starts in the middle of the room.  The operator 
then tells the turtle how to move.  The commands listed below 
will give you an idea.  

FORWARD 10     turtle steps.  Make them little steps if 
you are in a small space.

RIGHT 150      turtle turns.  

Remember how you turned right before?  You tried 
RIGHT 90 to turn to the side.  Then you tried RIGHT 180 and 
you turned around to face the opposite direction.  150 is closer 
to 180 than it is to 90.  So you can make a good guess about 
how far to turn.  It will do just fine.

FORWARD 11     turtle steps

LEFT 150       turtle turns.   

You don’t have to be reminded about this one, do you?  I 
bet you know which direction you should be heading.

FORWARD 10     turtle steps

Now type these steps on the computer.  Of course, you 
don’t need to type the “turtle steps” or “turtle turns.”  
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To clear the screen but leave the turtle in the same place, 
type CLEAN.  This cleans the screen, but the turtle stays where 
she was.

"That’s fine, but what about erasing all the typing in the 
Commander window?"

Just type CLEARTEXT.  The text disappears.

________________________________________________

Rabbit Trail 1. Turtle Games Off the Computer 

Now it’s my turn to shine!  Logy likes doing things at the 
computer.  But I have to get away every once in a while and 
do things off the computer.  So join me on my Rabbit Trails 
throughout these books.  Here’s one to get you started.

Have you ever played Simon Sez or Mother, May I?  Why 
not try these games using Logo commands instead of the 
regular things you do.  Logo commands add some new fun to 
the old game.

Simon sez FORWARD 5
Simon sez RIGHT 90
FORWARD 5
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That’s it.  Now just mess up the screen with turtle trails.  
As you type in numbers, watch what the turtle does.  Pretty 
soon, you’ll be able to tell the turtle just where you want her 
to go.  

________________________________________________

Cleaning Up After Yourself
By now the screen is either a work of art or a big mess.  

So you’d better clean it off.  To clear the screen, type:

CLEARSCREEN

Everything on the graphics screen is erased and the 
turtle goes HOME.

Yep, that’s the turtle’s home, right there in the middle of 
the Graphics window.  OK, so maybe HOME on the screen 
doesn’t look exactly like our picture.  But you get the idea.

When you tell the turtle to go HOME, she goes back to 
the middle of the screen and faces the top of the screen.  

Remember this!   You’ll use the HOME command a lot.
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RIGHT 90 RIGHT 90  (Yes, you can type more than one 
command on a line.  Just remember to press Enter when you’re 
done!)

That should work, shouldn’t it?

What would happen if you add the 90 and 90 together?  
Did you get 180?  Morf did.  Why not give that a try.

RIGHT 180  Then press Enter.

That did it!   There’s the turtle facing in the opposite 
direction.  

________________________________________________

Things to 
Remember

So, when tell the turtle to go FORWARD or BACK, the 
turtle moves forward or back the number of turtle steps you 
tell her to go.  When you tell the turtle RIGHT or LEFT, she 
turns the number of turtle turns you tell her to turn — but she 
doesn’t move.

Get the idea?  Try a few moves on your own.

FORWARD 100 RIGHT 90

FORWARD 100  RIGHT _____

BACK _____   RIGHT _____

BACK _____   LEFT _____

LEFT _____ FORWARD _____
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__________ was too __________ (too big or too little?)

__________ was too __________ 

__________ was too __________ 

__________ was too __________ 

The answer is __________!

This is the cool part of Logo.  You get to discover all sorts 
of new things all by yourself.  You found that the turtle had to 
turn 90 turtle turns to look at the side of the screen.

Now, turn the turtle back to the top of the screen.  What 
do you have to type to do that?

If you said LEFT 90, give yourself a double-dip ice cream 
cone!

________________________________________________

Turning Around Now, what do you have to do to get the turtle to face the 
bottom of the screen?

Well, you could tell the turtle to face the side twice, right?
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If you accidentally hit the wrong key and end up with 
something like FORWRD 200, the turtle sends you a message 
such as:

I don’t know how to FORWRD

She’s nice about it.  So just type the command again, but 
without any more accidents.  

________________________________________________

Turning the Turtle
To turn the turtle, tell her to turn RIGHT or LEFT.  Again, 

just as you have to tell her how many steps to move forward 
or back, you have to tell her how many turtle turns to make.  

RIGHT ______  

Go ahead!   Type in a number — not an itty-bitty number. 
Make it a  pretty big one.

What happened?  The turtle turned to look in another 
direction, right?

OK, now turn her back to the direction she was heading 
before.  

Type LEFT ______ and use the same number of turtle 
turns that you used before.  Remember to press Enter.

Now the turtle is looking up toward the top of the screen 
again.   How many turns does the turtle have to make to look 
at the side of the screen?

What do you think?  Why not write down your answers?
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RIGHT

When you tell the turtle to move, you have to tell her how 
many turtle steps to take.  Go ahead.  Try it.  

1. Type FORWARD.  

In this book, we sometimes use italics like this to make 
sure you know what’s going on.  However, we type 
commands in UPPERCASE so you’ll know what’s a 
command and what’s not.  When typing MSW Logo 
commands on the computer, you can use either upper 
or lower case letters, or both.

2.  Press the Space bar.  

3.  Then type a pretty big number, like 200 maybe.

4.  For the turtle to hear you, you have to press Enter.    

________________________________________________
SPECIAL NOTE: If you see the name 

of a key printed in bold, like Press Enter, 
you had better pay attention.  

That means press that key now.  
 If we don’t want you to press the key 

right then — you can do it the next time 
you use that instruction or command — 
then the key is displayed in regular type.

________________________________________________
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But remember, you are the one who has to tell her exactly 
what to do.  

________________________________________________

Turtle Directions
The turtle can go

FORWARD

BACK

LEFT
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Meet the Turtle
It’s also time to get down to business!

Look in the Commander window.  If you don’t see a 
blinking line over on the left side, left-click (that means press 
the left button on your mouse) in the Input Box.  That blinking 
line you see is “the cursor.”  It moves every time you type 
something in a window, dialog, or text box.  

But you probably knew that already.  So, let’s get on with 
the fun!

Ernestine carries a pen that she uses to create all sorts of 
colorful drawings.  Sometimes we call the lines that she draws 
turtle trails.
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________________________________________________
SPECIAL NOTE:  When we want you 

to pay special attention to something, we 
use this Special Note box.  These are things 
you really need to know.

Right now, we have a special note about 
this book that we want you to read before 
we get started.

When reading about menus and the things you can do with 
them in this book, you may see things like File/Edit or  Edit/
Copy.  This is just a short way of saying open the File menu 
and left-click on Edit, or open the Edit menu and left-click on 
Copy.  

Sometimes you may see instructions like File/Edit/All.  
You got it.  That means open the File menu, select Edit, and 
then left-click on All in the box that appears.

________________________________________________

Ready to Start Ready to get started?  Fine, it’s time to...



 Getting Started

                                                                                                     13

Demo:  Select Demo to see a neat demonstration of some of 
the things that MSW Logo can do.
Examples:  Examples are just that, examples of MSW Logo 
procedures.  Study these procedures after you finish this 
book to discover lots of other things you can do with MSW 
Logo.

Release Notes:  This tells you all about the things that MSW 
Logo has to offer.  It’s the same as the MSWLOGO.TXT file 
in your MSW Logo directory.  

About Logo:  This tells you who developed MSW Logo.  It 
also provides e-mail addresses where you can contact the 
developers.
________________________________________________

Commander 
Buttons

Morf loves buttons and things.  So here’s a list of the 
Commander buttons.  We’ll talk more about them later as we 
go along.

Halt:  This stops all the Logo action right away.  It does the 
same thing that the HALT command does.

Trace:  This turns the Trace command on.  Left-click on it to 
turn the Untrace command on.

Pause:   Logo stops the action temporarily and waits for the 
Continue command.

Status:  The Status button brings up a Status window that 
tells you what’s going on.

Yield:  This tells Logo not to allow other programs to run 
while Logo is running.

Reset:  This button is like the Clearscreen command.  It 
resets or clears the screen.

Execute:  This is like pressing the Enter key.  It tells the 
turtle to execute your procedure.

________________________________________________
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Set:  You can change the type of letters and numbers that 
Logo uses by setting the “font” in this menu.  You can also 
set colors.

Zoom:  You can Zoom in on your pictures to make them 
bigger.  Or you can Zoom out to make them smaller.

Help:  This is real important.  So we give you an entire 
section on it.
________________________________________________

Where to Go 
For Help

If you have questions about how to do something in MSW 
Logo,  you can left-click on Help.  The Help Menu pops up 
and gives you some choices. 

 

The Help Menu gives you some choices:
Index:  Left-click on Index to see a list of the chapters in the 
MSW Logo On-line Help.
MCI:  This is for Multimedia programmers, something we 
won’t be covering in this book.
Using Help:  This is a neat section.  It will help you if you 
need help using Help.  

Does that make sense?
Tutorial:  That didn’t make it in this version.  This book will 
have to do.  You’ll find the tutorial on CompuServe and on 
the MSW Logo home page at http://www.softronix.com.  
That’s also a great place for help.
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1. Left-click in the Title Bar where you see the word, 
Commander.  

The title bar of the Commander window changes 
color.

2.  Press and hold the left mouse key down.  Then drag the 
Commander window around the screen.

The Commander window moves as you move the 
mouse.

3.  Move the Commander window back where it is supposed 
to be and release the mouse button.

You’re back where you started.
________________________________________________

MSW Logo 
Menus

There are five menus in the Menu Bar. You know what a 
Menu is, don’t you?  You left-click on the word and up pops 
a list of choices.

File:  This gives you a list of things you can do with your 
procedures; things like Load them into your workspace, Save 
them, Save them using another name, Edit them, and Erase 
them.

Bitmap:  Bitmap is a technical term for picture.  This menu 
includes commands for loading, saving, and printing the 
pictures that you create.  See page 55 for more on printing.

(This is the File menu.)
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Parts of the 
Screen

There's Ernestine sitting at right in the middle of her 
playground.  Ernestine looks like a pointed arrow but she's 
really a turtle who does just about anything you ask her to do.  
If she doesn’t understand, she’ll tell you.

Now let’s take a look at the rest of the MSW Logo screen.

It’s like many Windows screens.  The Title Bar is at the 
top.  This tells you what window you’re looking at.  

The Menu Bar is right below the Title Bar.  It holds the 
names of menus we’ll describe a bit later.

Down below the playground is the 
Commander window.  This is where the 
action is.

  
The big space in the Commander 

window is the Command Box.  This box 
keeps a list of what’s going on.  If 
something goes wrong, you’ll see a 
message here. 

Below the Command window is the 
Input Box.  This is where you type your 
instructions to the turtle.

Over on the right side, There are a bunch of buttons that 
can make things a little easier. 

The Commander window is a separate window from the 
MSW Logo window.  That means you can move it around, 
make it smaller or larger, or you can change it into a little icon.  
We work with this window a lot.  So if you want to practice 
moving it around or changing its size, go ahead.
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Looking at 
Logo

When you install MSW Logo, Windows puts it in its own 
program group or folder.  Open the program group or folder 
and there’s Logo in its own little window.  

Double-click on the Logo icon in that little window to 
open MSW Logo.  The MSW Logo Screen appears.

________________________________________________

Title Bar
Menu Bar

Turtle’s Playground

Turtle

Commander
Input Box
Command Box
Command Buttons

 Window
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MSW Logo 
Directories

When MSW Logo is installed, three directories are set up:
•  Mswlogo:  This is the main directory or folder.  

Examples and Logolib are subdirectories of the main 
directory. This is the where you will save your own 
procedures.

•  Examples:  This directory includes a number of 
subdirectories with different types of MSW Logo 
sample procedures.  
Be sure to read the README.TXT file.  This 
provides a description of all the example procedures.
NOTE:  MSW Logo procedures are standard ASCII 
text files that you can read using a text editor or word 
processing software.  Just be careful that you don’t 
change them.

•  Logolib:  This is a file of special Logo primitives — 
that’s the Logo word for commands — used by MSW 
Logo.

To see a few of the things that MSW Logo can do, run the 
Demo.

1. Left-click on Help in the menu bar.  (That means to press 
the left mouse key.)

2.  Select Demo to get a preview of MSW Logo.

________________________________________________

The Procedures 
Diskette

The procedures diskette that came with this book has four 
directories.

Procs:  This directory includes all the procedures from
The Logo Sourcebook.

Projects:  Other procedures you may enjoy working with.
A:\ Some text files referred to in the book.
PCX: Pictures to use with the activities in this book.

Be sure to read the README file in the A:\ directory.  It 
describes the diskette files.
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Chapter 1. Getting Started                                                                 

“Hey, Logy, whatcha doing?”

“What’s it look like I’m doing.  I’m 
cleaning the windows so we can get started 
on our new adventure.”

“Can’t you leave the housekeeping 
until later.  We’ve got Logo work to do!”

“I don’t like dirty windows!" replied 
Logy.  "I don’t care if they are on the house 
or on the computer.  If we’re going to 
discover new things to do with Logo, we’re 
going to have clean windows.

“Did you know that Ernestine brought along her whole 
family, over 1,000 turtles.  And you can now play music 
through your new sound card.  You can even use Logo to make 
up your own Windows stuff for your friends to use.  Just wait 
until you see the trouble you can get into!”

“Yeah, yeah, yeah” Morf said, bounding around excitedly.  
“What do we have to do?  When can we get started.  I’ve got 
lots of ideas I want to try out!”

________________________________________________

Installing  Logo
The first thing you need to do is install Logo on your 

computer.  Put your MSW Logo diskette in Drive A.  To install 
MSW Logo, just type the name of the MSW Logo file from 
the DOS prompt or select the RUN command in Windows.  
Then run A:\SETUP.  The rest is automatic.


